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INTRODUCTION 

WELCOME… 
… to SANAKO Study 500, a software-based teaching 
solution that combines the use of multimedia with a suite of 
essential classroom management tools. Study 500 helps 
teachers deliver effective instruction in any subject area. 
Since it is a pure software solution, Study 500 does not 
require any additional hardware and is therefore easy to 
install and maintain. 

WHAT CAN YOU DO WITH STUDY 500 
The Study 500 multimedia teaching environment includes all 
the features and functions that are essential for effective and 
enjoyable teaching and learning, such as screen transfer 
features, audio and text communication tools, web browser 
and program launch capabilities, and classroom 
management and control features. 
The basic platform of the Study 500 system can be easily 
upgraded and enhanced with separate extension modules, 
making it a flexible solution that can be modified to suit your 
specific teaching needs. 
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GETTING STARTED 

STUDY 500 SYSTEM COMPONENTS 

STUDY 500 TUTOR 
Teachers use the Study 500 Tutor application, which is the 
main interface to the Study 500 system. The Tutor 
application allows teachers to instruct with the Study 500 
system and to control the classroom computers. 

STUDY 500 STUDENT 
The Study 500 Student application is installed onto all 
student computers. Study 500 Student connects to SANAKO 
Crossroad at system startup and runs in the background 
listening for commands from Study 500 Tutor.  
Students can open the student interface to work 
independently, however, teachers are able to control student 
computers, regardless of whether the Student application is 
visible on student screens. 

SANAKO CROSSROAD 
The SANAKO Crossroad server program is the information 
center of the SANAKO Study 500 system and both the Tutor 
and Student components automatically connect to it. All 
system data is passed through SANAKO Crossroad and it 
allows communication between the Tutor and Student 
components. 
If you do not have a separate server computer, you can 
install SANAKO Crossroad onto the same computer as 
Study 500 Tutor. 
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EXTENSION MODULES FOR STUDY 500 
The functionality of the Study 500 system can be extended to 
suit more specific needs and tasks with additional modules. 
The available extension modules for Study 500 include:  

• SANAKO Study Admin Module 

• SANAKO Study Blackboard Module 

• SANAKO Study Content Authoring Module (included 
in the Study 1200 package) 

• SANAKO Study Examination Module 

• SANAKO Study Mobile Module (available in UK only) 

• SANAKO Study Voting Module 

• SANAKO Study Video Streaming Module 
You can find descriptions and more information on each 
extension module in the Extension modules for SANAKO 
Study 500 section at the end of this User Guide. 
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STUDY 500 TEACHER 
APPLICATION 

OVERVIEW 

SESSIONS & ACTIVITIES 
Sessions and activities are two key concepts that form the 
basis of teaching with the Study 500 application 

SESSIONS 
In Study 500, students can be divided into six different 
sessions that can be controlled separately and that can 
simultaneously perform different activities. 

ACTIVITIES 
Teaching in the Study 500 environment is based on a set of 
preset learning activities, which can be utilized in the basic 
teaching of any subject. You can set different activities for 
different sessions. 
The Study 500 program includes the following activities: 

• Self-Access 

• Tutoring 

• Web Browsing 
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COMPONENTS OF THE TUTOR INTERFACE 

 

MENUS 

 
The three menus (File, Tools and Help) give you access to 
settings and preferences, to your license information, and to 
online help. 

CLASSROOM VIEW 

 
You can edit the classroom view by adding and removing 
student workstations and by arranging them to match your 
physical classroom environment. Student icons are color-
coded according to the sessions they are in. 

Menus 

Classroom view 

Sessions 

Function buttons 

Activity 
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SESSIONS 

 
Study 500 has six different sessions that students can be 
placed into. The sessions allow you to divide your class into 
smaller groups that can be engaged in different learning 
activities. Empty sessions are grayed. 

FUNCTION BUTTONS 

 
The different functions can be used for either all the students 
or the students of a single session. 
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ACTIVITY VIEW 

 
The activity view is where you can select and control the 
activity of the current session. 

COMMUNICATION 
To discuss with a single student, click a student icon and 
select Discuss.  
To talk to a session, select a session and in the Function 
Buttons click the icon next to the Talk button. 

 
To talk to the entire class, click on Talk in the Function 
Buttons. 

 

FUNCTIONS 

FUNCTIONS FOR A SINGLE STUDENT 
To use the different functions for a single student, click on 
the student icon. This opens a student monitoring window 
with functions that apply to the selected student. 
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For more information on the different functions in the 
monitoring window, see Functions for a single student later in 
this guide. 

FUNCTIONS FOR ENTIRE CLASS / A SESSION 
The functions in the function buttons can be used for the 
currently selected session or for the entire class. 

•  Clicking the button itself will perform the function for 
the entire class. 

 

For the entire 
class 
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•  Clicking the icons will perform the function for the 
current session. 

 
For more information on the different function buttons, see 
Functions for entire class / a session later in this guide. 

For the current 
session 
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GETTING STARTED 

STARTING STUDY 500 TUTOR 
After the installation, you are ready to start Study 500. To 
start Study 500 Tutor, open the Windows Start menu (lower 
left corner on your screen) and select Programs – SANAKO 
Study 500 – Tutor. 

SELECTING TUTOR NAME AND CLASS 
Before the Tutor application opens, you need to select your 
tutor name and the class that you are teaching. If you are not 
teaching a specific class, you can select the template class 
or an empty class and then manually pick the students you 
want to include in the class. 

 
For information on adding students to the classroom, see the 
Adding students into the classroom section below. 
For information on setting tutor names and classes, see the 
Study 500 Technical Guide. 

STARTING STUDY 500 STUDENT 
To open the Study 500 Student interface, click the Windows 
Start menu and select Programs – SANAKO Study 
Student – Study Student. The teacher can also at any time 
display the Student applications on student workstations by 
clicking on the Student Applications button on the Tutor 
interface. 
Even if the Study 500 Student application is not open on the 
student screen, it is always running in the background 
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listening to commands from Study 500 Tutor when the 
student workstation is on. 

ADDING STUDENTS INTO THE CLASSROOM 
To add students into the classroom, click the Show Corridor 
text at the bottom of the Tutor interface.  

 
This opens a window that displays all the currently running 
student workstations. Select the workstations that you want 
to add and then click the Add to session A button. 

 

MOVING AND ARRANGING THE STUDENT ICONS 
To move and arrange the student icons on the classroom 
view, open the Tools menu, select Admin and then Move 
and align student icons. This opens a control bar with 
functions for arranging the classroom layout.  

EDITING STUDENT NAMES AND NUMBERS 
To edit the student names and numbers, right-click on a 
student icon and select Edit and then either Name or 
Position.  
You can also let the students enter a name for themselves. 
To do this open the Tools menu and select Ask student 
names. 

REMOVING STUDENTS 
To move a student from the class back to the corridor, right-
click a student icon and select Send to corridor. The 
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student can then be selected to another class by another 
teacher. 
To remove a student and the student icon from the class 
view, right-click a student icon and select Exclude from 
class (and layout). Once the student icon is removed, the 
classroom configuration can be saved as a new class. 

GETTING HELP 
If you are unsure of some of the functions in the applications, 
you can access the Study 500 online Help file in either the 
Teacher or Student application by opening the Help menu 
and selecting Help. 

ENDING A LESSON 
To end the current lesson and close Study 500 Tutor, open 
the File menu and select Exit or click the ‘X’ button in the top 
right corner of the teacher application. 

RESTARTING THE TUTOR APPLICATION 
To restart the tutor application, open the File menu, select 
Restart and then either the Restart option to start again with 
the same tutor and classroom, or the Restart and select 
Tutor option to start again with a different tutor and 
classroom. 
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GROUPING STUDENTS INTO SESSIONS 
You can place students into six different sessions (A-F). 
Empty sessions are grayed. 

 
There are three ways to select students for a session: 

• Click Add and then the student icon you want to add. 

• Click Add, and with the left mouse button pressed 
down drag the selector over the desired student icons. 

• Right-click a student icon, select Move to Session 
and the letter of the session you want to place the 
student into. 

You can remove students from a session by adding them 
into another one in one of the ways explained above. 
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STUDENT ICONS 

CLASS VIEW 
The Study 500 class view is a graphical layout of your class. 
Your students are displayed as student icons that reflect their 
current status. 

 
The student icons are also color-coded according to the 
session they are in, allowing you to see at a glance, which 
session the students belong to. 

STUDENT ICONS 

 Student name and position 
Student names and student position numbers are indicated 
below each student icon.To edit the name or position of a 
student, right-click the icon, select Edit and either Name or 
Position. 

 Student calling teacher 
A question mark on top of the student icon indicates that the 
student wants to speak with the teacher. To talk with the 
student, click the student icon and select Discuss. 
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 Message from student 
Messages from students are displayed above the student 
icons 

 Locked student  
A locked student workstation (Lock PC, Lock Screen, or Lock 
Mouse and Keyboard). 

 Student receiving tutor screen 
A student who receives the Tutor screen, when the Tutor 
screen is shared to students. 

 Student receiving model student’s screen 
A student who receives the Model Student screen, when a 
student screen is shared to others. 

 Model student 
A student whose screen is being shared to other students 
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FUNCTIONS FOR A SINGLE STUDENT 
Clicking a student icon opens a student monitoring window 
with functions that apply to the selected student. 

 

DISCUSS 
Talk with the student. Adjust the student volume with the 
slider during the discussion.  

PC CONTROL 
PC Control options include shut down functions, locking 
functions, the possibility to launch programs, disable Internet 
use and show or hide student applications on the student 
computer. 
For information on the different PC Control options, see PC 
control options later in this guide. 

REMOTE CONTROL 
View and control the selected student’s screen in the Screen 
Control window. 
For more information on the functions in the Screen Control 
window, see Screen Control window later in this guide. 
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MESSAGES 
Opens the message window in which you can send a 
message to the student. 

 

TO SEND A MESSAGE 

1. Type your message in the Message text field. 
2. The current student is selected as the recipient by 

default. 
3. Click Send. The message is now displayed on the 

student screen. 
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FUNCTIONS FOR ENTIRE CLASS / A SESSION 
The functions in the function buttons apply either to all 
students or to the currently selected session. 

• Clicking the buttons will perform the function for the 
entire class. 

 
• Clicking the icons will perform the function for the 

current session. 

 

TALK 
Talk allows you to talk to students while the student 
microphones are muted. To end the call, simply click the 
Talk button again. 
The Talking to students text above the Function buttons 
indicates when the students can hear you. 

 

Control the 
entire class 

Control the 
current session 
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PC CONTROL 
The different PC control options give you full control over the 
shutdown functions of student computers and also allow you 
to launch programs, disable Internet use and show or hide 
student applications on student workstations. With the 
locking functions you can ensure that the students’ full 
attention remains on the task at hand. 

 
For more information on the different PC control options, see 
PC control options later in this guide. 

SCREEN CONTROL 
The different screen control options allow you to monitor and 
control student screens, as well as to share either the 
teacher screen or a selected student’s screen to others. 

 

AUTOSCAN 
Opens the Screen Control window and allows you to monitor 
the screen activity of student workstations automatically, one 
after the other. 
For more information on the functions in the Screen Control 
window, see Screen Control window later in this guide. 
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THUMBNAILS 
Selecting Thumbnails displays thumbnail images of student 
screens in place of the student icons. 

 

TUTOR SCREEN TO STUDENTS 
This allows the teacher to display the teacher screen on the 
student screens while talking to them. During the screen 
sharing, students will see the teacher screen but are not able 
to use their keyboard or mouse to control it. 

ON THE AIR 

When the Tutor screen is shared to students an On The Air 
indication panel appears in the lower-right corner of the tutor 
screen 
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To end the screen transfer, click on the Stop Transfer 
button in the On The Air panel. 

 

MARKER TOOL 

The marker tool allows instructors to make annotations onto 
the shared tutor screen. To use the Marker Tool, click on the 
Marker Tool button in the On The Air panel. 

 
This will open a toolbar with different annotation tools into the 
top right corner of the Tutor screen. 

 
 
 
 

 
 
 

Select annotations by dragging 
the selector over them 

Drawing tools: line, 
arrow, square, circle 
and free-hand. 

Type in text or 
place a pointer

Selections for color 
and width of line 

Clear the drawings 
and minimize or close 
the marker tool bar. 
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MODEL SCREEN TO STUDENTS 
This displays a selected student’s screen to the other 
students and the model student can also talk to the others. 
Instead of teaching all the sessions yourself, you can use 
screen sharing to set one of the students to instruct the 
others or to let a student give a presentation. 
To set a model student, select Model screen to students 
and then click on the desired student. 

ONENOTE 
Microsoft OneNote is a tool for note taking, information 
gathering, and multi-user collaboration. The application 
allows teachers to distribute their classroom notes to 
students in the Study live learning session. 
Clicking the OneNote button launches Microsoft OneNote for 
both the teacher and students. Teachers can then click the 
Send button to send their notes and content to the students.  

The entire page content will be always updated in the 
students’ OneNote when the tutor clicks Send. A new page 
will be created for the students if one does not already exist. 
Note: The OneNote feature requires that Microsoft OneNote 
is installed on the tutor and student computers. Microsoft 
OneNote is a standard part of Office 2007. 

WEB BROWSER 
Launch – Open Web browsers for the student and the tutor. 
You can use the tutor Web browser to control the student’s 
browsing. 
Hide – Close both the student and tutor Web browsers. 
For more information on how to use the Web Browser and on 
how to control and set limits to students’ navigation, see Web 
browser later in this guide. 

WHITEBOARD 
The Whiteboard is a tool that allows users to make 
annotations onto selected images. You can use any pictures 
as the background of the Whiteboard. 
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The Study 500 Whiteboard opens in a separate window. 

 

FILE MENU  

 
New – Clear the Whiteboard and start a new project. 
Open… – Open a saved Whiteboard project. Whiteboard 
projects include the background image and the annotations. 
Save – Save the current Whiteboard project under the same 
name.  
Save As – Save the current Whiteboard project as a 
Whiteboard project file, in which case the drawings can later 
be edited, or as a picture which cannot be edited. 
Exit – Close the Whiteboard window 
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EDIT MENU 

 
Undo – Undo the previous command. 
Cut – Cut the selected annotations and pictures. You can 
select annotations and pictures with the Selector tool.  
Copy –Copy the selected annotations and pictures. 
Paste –Paste any annotations or pictures that you have 
copied onto the Whiteboard. 
Delete – Delete the selected annotations or pictures. 
Bring to Front – Bring the selected picture on top of the 
others on the Whiteboard.  
Send to Back – Send the selected picture behind the others 
on the Whiteboard. 
Select All – Select all the annotations and pictures on the 
Whiteboard. 

INSERT MENU 

 
Insert a picture onto the Whiteboard. You can insert and 
arrange multiple pictures onto the Whiteboard. 

OPTIONS MENU 

 
Background -- Select a new image to be used as the 
Whiteboard background or clear the background. If the 
‘Automatically Clipboard’ option is selected, any image that 
you capture or copy is automatically pasted as the 
Whiteboard background 
Color – Select the color of the Whiteboard drawings. 
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Width – Select the width of line for the Whiteboard drawings. 
Text – Select a text font style and size for the text tool. 

WHITEBOARD TOOLS 
 
 
 

 
 
 
 

MESSAGES 
The message function allows you to display messages on 
student workstations, for example, to offer them additional 
guidance and instruction. 

TO SEND A MESSAGE 
1. Type your message into the Message text field. 

 
2. Select the message recipient. 

 
3. Click Send. The message is now displayed on student 

screens. 

Select annotations and 
pictures by dragging the 
selector over them 

Drawing tools: line, 
arrow, square, circle 
and free-hand. 

Type in text or 
place a pointer

Select the color and 
width of line 
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CHAT 
The text chat feature can be used by both teachers and 
students for quick and easy communication, without 
disturbing the other students. 
Clicking Chat opens the Chat window. Study 500 has 
separate chat rooms for each session and you can either 
view the chat history of a single room or monitor all the chat 
rooms simultaneously in a mosaic window. 

 
Click on the letters to select which session’s chat history is 
displayed in the Chat window. 

 
If All is selected then all six sessions are displayed 
simultaneously, allowing you to monitor all the chat 
discussions at the same time. 

ENABLE / DISABLE CHAT FUNCTION 

 
The Chat function is unavailable for students, until you 
enable it for them. Clicking this button will enable or disable 
the chat function for the session that is currently displayed, 
or if you are in the All view, for all sessions. 

TO SEND A CHAT MESSAGE 
1. Type your message into the field at the bottom of the 

window. 
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2. Click Send. 
3. The message will be displayed for the currently selected 

session, or if you are in the All view, for all sessions. 

SAVE / PRINT / CLEAR CHAT HISTORY 
Click on the icons at the upper right corner to  

 save,  
 print, or 
 clear  

the currently displayed chat history, or if you are in the All 
view all the chat histories. 
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FILE FUNCTIONS 
All the file functions of Study 500 are available in the Files 
window. To open it, click on Files in any session tab. 

 
The Files window displays the Session file area(s) (top half 
of the window) and the Tutor file area (bottom half of the 
window). 

 

SELECTING ACTIVE SESSION FILE AREA 
Study 500 has separate file areas for each session and for 
the tutor. You can use the session file areas to provide the 
students with material that they can access themselves. 
Click on the letters to select which session’s file area is 
displayed. 

 
If All is selected then all six session file areas are displayed 
simultaneously. This allows you to add, copy and launch files 
to all the sessions at once. 

BROWSING THE TUTOR FILE AREA 
The Tutor file area is for storing files that you may use during 
your lesson. You can browse the folders and create new 
subfolders with the function buttons at the top right of the 
Tutor file area. 

 Move up in the folder structure 

 Create a new folder 

Open the Files 
window 

Tutor files 

Session files 
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COPYING FILES 
To copy files from the Tutor file area to the Session file 
area(s) or vice versa, click on a file in the Files window to 
select it and then click on the Copy button.  

 
Depending on which file area the selected file is located in, 
the arrow in the Copy button changes automatically to 
indicate whether the file will be copied from the Tutor file 
area to the Session file area(s) or vice versa. 

FILE FUNCTIONS 
File functions are located at the top of the Files window  

 

 Settings allow you to change the location for storing 
session files and refresh the file lists 

 Open the selected file on the tutor screen 

 Launch the selected files for students  

 Launch files that are located outside the session file 
areas 

 Close the selected files on the student workstations 

 Close all launched files  

 Add files to the active file area 

 Remove the selected file 
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PC CONTROL OPTIONS 
PC Control options include shut down and start up functions, 
locking functions, and the possibility to launch programs, 
disable Internet use and show or hide student applications 
on the student computers. 

 

SHUT DOWN OPERATIONS 
Selecting Shutdown operations opens a dialog that allows 
you to control the shutdown functions of student computers. 

 
Checking the Allow students to save their open files 
option will let the students save open files before the 
selected shutdown command is performed. 
Shut down – Shut down student computers 
Log off – Log off current users on student computers 
Restart – Reboot student computers 

SWITCH ON STUDENT PC 
Selecting Switch on Student PC starts up the student 
computers in the group or classroom.  
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Note: This function requires that Wake-On-LAN has been 
enabled on the student PC network cards.  

LOCKING OPTIONS 
Lock PC – Students’ screens are blacked out and students 
are unable to use neither their keyboard nor mouse. You can 
then launch files or applications on top of the blank screen. 
To unlock the student computers, re-click the option. 
Lock screen – Students’ screens are blacked out, but 
students can still use their mouse and keyboard to work with 
anything you launch on their screen. To unlock the student 
computers, re-click the option. 
Lock keyboard and mouse – Students are able to view 
their own screens, but will not be able to use their keyboard 
or mouse. To unlock the student computers, re-click the 
option. 

LAUNCH PROGRAM 
Selecting Launch program allows you to launch any 
programs on the student computers or in a shared area for 
the students, as well as create shortcuts to programs that are 
frequently used.  

TO LAUNCH A PROGRAM FOR STUDENTS 

 
1. Either type in the name of the program or click 

Browse to browse for it (*.exe files). 
2. Select whether the program window on student 

screens should be Normal size, Maximized, or 
Minimized to the taskbar. 

3. Click Launch. 
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TO CREATE A SHORTCUT 

 
1. Click Browse to browse for a program  
2. Click Save program shortcut to shortcuts list to 

create a shortcut to the selected program. 
3. You can now launch the program to students simply 

by double-clicking the shortcut. To remove a shortcut, 
simply select it and press Delete on your keyboard. 

TO CLOSE A LAUNCHED PROGRAM 

 
1. Select a launched program that you want to close on 

the list. 
2. Select whether you want to allow students to save 

their work before the program is closed. 
3. Click on the Close button to close the selected 

program or click on the Close all button to close all 
launched programs 

SHOW STUDENT APPLICATION 
Clicking this button will either show or hide the student 
applications on the student screens. 



34  •  SANAKO Study 500 User Guide  

DISABLE INTERNET 
Selecting Disable Internet prevents the students from 
opening and using Web browsers on the student 
workstations. 
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SCREEN CONTROL WINDOW 
The screen control window has all the functions for 
monitoring and controlling student screens. 

 
Select a screen control mode with the buttons on top of the 
screen. 

 

MONITOR 
View the selected student screen and listen to the student. 

AUTOSCAN 
Autoscan automatically changes monitoring from one student 
to the next after a set period of time. 

REMOTE CONTROL 
Control the currently displayed student screen with your 
mouse and keyboard, for example, to help the student with a 
task. The student’s mouse and keyboard are locked during 
Remote Control. 

COLLABORATE 
Control the currently displayed student screen with your 
mouse and keyboard simultaneously with the student, for 
example, to instruct the student in the use of an application. 
Both you and the student will move the same mouse pointer. 
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FIT STUDENT SCREEN TO SCREEN CONTROL 
WINDOW 

 
Clicking on this button will fit the monitored student screen 
into the screen control window. 

NEXT / PREVIOUS STUDENT SCREEN 

 
Use the arrow buttons to change to the next or previous 
student screen. 
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WEB BROWSER 
The Study 500 Web browser contains all the functions of a 
standard browser, as well as additional features that allow 
you to control students’ navigation. 

 
The tutor’s Web browser 

BROWSER CONTROL BUTTONS 

 
Back moves back to the last visited Web page. 

 
Forward moves to the page you viewed before 
clicking the Back button. 

 
Stop stops opening and loading a Web page. 

 
Refresh gets the latest version of a currently 
viewed Web page. If a page cannot be 
displayed, you may try to reload it by clicking 
Refresh. 

 
Home moves to the default home page. 

 
Search launches an Internet search page. 

 
Print prints the current web page. 

 
Send opens student browsers on the Web 
page you currently have open. For more 
information see the To open Web browsers for 
students part later in this section. 

 
Follow makes student browsers follow your 
navigation. For more information see Follow 
mode later in this section. 
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Settings allows you to block pop-up windows 
and to show or hide the toolbar on student 
browsers 

TO OPEN WEB BROWSERS FOR STUDENTS 
1. You can open the Web browser for all students 

(Function buttons; button), for a session (Function 
buttons; icon) or for a single student (Click a student 
icon) 

2. Select one of the above. The tutor’s Web browser 
opens on your screen. 

 
 The tutor’s Web browser 

3. Go to the Web page you want student browsers to 
open. 
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4. Click Send. Web browsers will now open on student 
screens. 

 
 Student Web browser 

FOLLOW MODE 

 
In the Follow mode, students’ browsers will display the Web 
site that is open on the teacher’s browser. The students are 
only able to follow your navigation as the control buttons are 
hidden from their browsers. 

 
Student browser in Follow mode 

This allows you to browse the web and present material 
while student browsers follow your navigation. Once the 
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presentation is over, you can let students continue with 
independent study. 
To Enable / Disable the Follow mode, click on the Follow 
button. 

SETTINGS 
Settings allows you to block pop-up windows and show or 
hide the toolbar on student browsers. 

 
Blocking pop-up windows prevents any additional and 
unnecessary windows from opening automatically when a 
student opens a Web page. 
Hiding the toolbar on student browsers is useful when you 
want students to concentrate on the current Web page 
instead of browsing elsewhere. 
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ACTIVITIES 

GENERAL PROCEDURE 
Study 500 has seven pre-set learning activities that form the 
basis for teaching with Study 500. The Activity view only 
displays the options that are relevant to the currently 
selected activity. 

 

ACTIVITY SELECTION 
First of all, select an activity that you want to start for the 
current session. 

 

MEDIA SOURCE SELECTION 
The Media source is what the session hears during an 
activity. In Tutoring, the Media source’s screen is also 
transferred to the students.  

 
Tutor – You can talk to the students during the activity. 

To start an activity for a session 
 

1. Select a session 
 

2. Add students to a session 
 

3. Select an activity 
 

4. Select a Media source 
 

5. Activity specific settings 
 

6. Start / End activity 

2
3
4
 
 
 
5
 
 
 
 

6

1
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Student – A selected student can talk to the others during 
the activity.  
If you select Student as the media source, you need to then 
click on a student icon to select the source student.  
None – The activity will be run without a media source. 

Note: The Self-access activity does not have Media source 
selection. 

ACTIVITY CONTROLS 

 
Start – Starts the selected activity and plays the Media 
source to students 
End – Ends the activity. The media source is stopped and 
student players are set to free. 
If the media source was a file, the file will remain in the 
student players and they can listen to it again. 
Clear session – Clears all the settings and switches back to 
Self-Access. 

SELF-ACCESS 
In the Self-access activity, students have free access to use 
their workstations and the Study 500 Student application. If 
no other activity is selected, the students are always in Self-
Access. You can still use all the Study 500 functions to 
communicate with and control the students if needed. 

TUTORING 
In the Tutoring activity, the screen of the media source is 
transferred to the session and the source can also talk to the 
others. You can either select yourself or one of the students 
as the media source. 
If you select Tutor as the media source, the Study 500 Tutor 
application is minimized to the taskbar, allowing you to 
instruct students using any applications that are on the 
teacher computer. 
If you select Student as the media source, you can also 
select whether you want to view the student screen during 
the activity.  
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WEB BROWSING 
Starting the Web browsing activity launches Internet Explorer 
browsers on student workstations. You can set limits to their 
access to Web pages. 

 

WEB POLICIES: STRICT AND OPEN 

Open – students are able to access all Web sites, except the 
ones on the list. 
Strict – students are only able to access the Web sites on 
the list. 

 
To add an address to the list, type or copy it to the field at 
the bottom and click Add. 
To remove an address from the list, select the address and 
click Remove. 
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LOAD / SAVE / PRINT / CLEAR ADDRESSES  

Click on the icons to: 

 Load a previously saved file of denied / allowed 
addresses 

 Save the current list of addresses for later use 

 Print the current list of addresses 

 Clear the list of addresses 

OPEN MY BROWSER  

This opens the tutor Web browser, with which you can take 
control of the student browsers. 
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STUDY 500 STUDENT 
APPLICATION 

COMPONENTS OF THE STUDY 500 STUDENT 
APPLICATION 

 
SANAKO Study 500 Student interface 

The function buttons (Player and files and Chat) open new 
windows on the interface. 

Menus

Status display

Function buttons 

Call teacher / Send message 

Adjust volume / Mute speakers



46  •  SANAKO Study 500 User Guide  

 
SANAKO Study 500 Student interface with the Media Player and Chat windows 

Below, you will find short presentations of the components of 
the Study 500 student interface, each of which will be 
explained in more detail later in this guide. 

MENUS 

 
The three menus of Study 500 Student give you access to 
file functions, settings and preferences, and to online help. 

FUNCTION BUTTONS 

 
As shown above, the Player and files and Chat buttons 
open new windows on the interface, in which these features 
can be controlled. 

File functions

Player

Chat window
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PLAYER AND FILES 
Clicking Player and files opens a window that contains all 
file functions and the media player. 

 
For more information on file functions and using the player, 
see the Player and Files section later in this guide. 

CHAT 
The Chat function can be enabled or disabled by the teacher. 
When enabled, clicking Chat opens a window displaying the 
chat room of the student’s session and the other chat 
participants. 

 
For more information on the Chat function, see the Chat 
section later in this guide. 

VOLUME ADJUSTMENT 

 
To adjust your speaker volume, move the slider. 
To mute your speakers entirely, click the speaker icon next 
to the slider. 
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STATUS DISPLAY 

 
The field at the lower left corner of the Student application 
displays your current status: 

 the current activity set by the Tutor  
 your current session and position number 
 you have been set as a model student. This means 

that your screen is shared to the other students and you can 
talk to them. 

 the lock symbol indicates whether your player controls 
are locked or free 
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FILE FUNCTIONS 

 
New file – Clear the Player. The current file is removed from 
the Player. 
Open – Open a file. A browsing window opens allowing you 
to browse for the file. 
My files – Display the files in your personal file area 
Session files – Display the files in your session’s file area 
Exit – Exit SANAKO Study 500 Student 

Note: All of the file functions are also available in the Study 
500 Player. 

GETTING HELP 
The Help menu in the Student application allows you to 
access an online help file for Study 500 and to view version 
information on your Study 500 Student application 
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PLAYER AND FILES 
Clicking the Player and files button opens the Study 500 
Player that you can use to play back media files in commonly 
found formats, such as WAV, AVI, MP3, as well as in 
SANAKO’s own file formats MFF and MAA. This allows you 
to also use material created with the SANAKO Authoring 
tool, Lab 300, and Media Assistant. 

 
 
 
 

FILE FUNCTIONS 

 New  – Clear the Player. This will close the currently 
open file and remove all bookmarks. 

 Open  – Open a media file for the Player. This opens a 
dialog in which you can browse for a file. 

 
My files – Display the files in your own personal file area. All 
students have personal file areas where they can store files 
for themselves. 
Session files – Display the files in your session’s file area. 
Each session has its own file area. 

TRACK DISPLAY 

 

Display the files in 
your personal or your 
session’s file area 

Clear the Player, 
Open new file 

The files in your 
personal or your 
session’s file area 

Bookmarks

Player controls

The open file, its 
total length, and 
the time played 
from the file 
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To isolate a segment of the media file to be played 
separately move the small tabulators at each end of the track 
display by holding your mouse button down over them. 

BOOKMARKS 

 
Bookmarks allow you to mark places to return to in the 
program. Clicking a set bookmark will start playing from the 
selected place. 
To set a bookmark, click Set. This will add a mark in the 
numerical order. 

 
To clear unwanted bookmarks, click Remove and then the 
appropriate bookmark. 
To name a bookmark, right-click the bookmark to open a 
dialog in which you can enter a name for the bookmark. 

  
The bookmark name is then displayed as a tooltip when you 
move the mouse pointer over the bookmark 

PLAYER CONTROLS 

 Play – Plays the open file. 

 Pause – Pauses the file. When a file is being played, 
the Play button turns into Pause. 

 Stop – Stops the file. 

 Repeat – Repeats the selected segment or entire file. 
 

Isolate a segment to 
be played separately. 
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CHAT 
The teacher can enable and disable the Chat function for the 
students. When enabled, clicking Chat will open the Chat 
window. 

 
All sessions have their own chat rooms in Study 500. The 
Chat window displays the chat history and participants of the 
session you are currently in. 

TO SEND A CHAT MESSAGE: 
1. Type in your chat message in the Chat input field 

 
2. Click Send. Your chat message is displayed in the Chat 

output window. 
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CALL TEACHER / SEND MESSAGE 
Whenever students need to communicate with the teacher, 
they can either call the teacher or send a written message. 

 
 
 

TO CALL THE TEACHER 
1. Click the Call button. 
2. The teacher screen will now display a question mark 

on top of your student icon, indicating that you want to 
talk with the teacher. 

TO SEND A MESSAGE TO THE TEACHER 

1. Click the Message icon . This opens a Message 
window. 

 
2. Type in your message. 
3. Click Send, the message will be displayed on the 

teacher screen. 

Call teacher Send message
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WEB BROWSER 
The teacher can launch Web Browsers for the students at 
any time and has the possibility of controlling students’ 
navigation. 

 

TEACHER CONTROL 
If the teacher sets the student browsers into Follow mode, 
student browsers will only display the page that is open on 
the teacher’s browser. Students are also unable to navigate 
as their control buttons are grayed. 
The teacher can also set limits to students’ navigation by 
defining allowed and denied Web pages. 
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LOCKING 
The teacher can use different locking options in order to 
draw the students’ attention to the current task. 

 
Locked student screen with an open application 

If the teacher has locked your PC, your screen is blacked 
out and you can only view files and applications that the 
teacher opens. 
If the teacher has locked your screen, it is blacked out but 
you can still use your mouse and keyboard to work with the 
files and applications that the teacher opens. 
If the teacher has locked your mouse and keyboard, you 
can see your own screen, but cannot use your mouse and 
keyboard. 
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EXTENSION MODULES FOR 
SANAKO STUDY 500 

SANAKO Study extension modules enhance teaching and 
learning effectiveness and provide instructors with a powerful 
array of new teaching tools. 
Note: The extension modules presented below are available 
with the purchase of a separate extension module license for 
each module. 

SANAKO STUDY ADMIN MODULE 
SANAKO Study Admin Module facilitates the smooth and 
effortless functioning of the SANAKO Study software 
teaching environments. This useful tool helps system and 
network administrators support and guide teachers and 
students by providing the administrators a range of 
resources to monitor teaching and learning activity in the 
network. Additionally, the Admin module provides basic tools 
for diagnosis of common usage problems in the system. 
The features in the Admin Module allow for a range of 
supervisory activities: system administrators can monitor 
student activity, view thumbnails, remote control or shut 
down workstations, as well as discuss with workstation users 
while handling and investigating issues. This allows an IT 
supervisor to manage class activity, useful in situations when 
a teacher may not be present, or to provide teachers with live 
remote support when needed. 
The module will also provide system administrators with a 
general PC information overview on all workstations 
connected to the Crossroad. System administrators will be 
able to view a thorough listing of the current status and 
technical configuration of the Study applications on any 
workstation in the network, which can be helpful when 
identifying problems or performing troubleshooting actions. 
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SANAKO STUDY BLACKBOARD MODULE 
The SANAKO Study Blackboard Module allows teachers and 
learners to instantly use Blackboard course materials in live, 
teacher-led learning situations, as well as in the 
asynchronous Blackboard learning environment.  
The Study Blackboard module provides teachers with instant 
access to the Blackboard LMS by creating a “portal” in the 
Study software. By selecting this access point, the teacher 
opens a connection in the Blackboard server, which allows 
them to download files and other course material into the 
SANAKO Study file area for use in live classroom teaching.  
In addition to collaboration in the classroom, students can 
continue practicing with the lesson material independently. 
Once the teacher has made material available for students 
through the Blackboard module, the students can access the 
lesson content individually for self-paced learning. 

SANAKO STUDY CONTENT AUTHORING MODULE 
SANAKO Study Content Authoring Module is an easy-to-use 
tool for creating varied and motivating multimedia teaching 
content. With the Content Authoring Module the teacher can 
combine text, images, audio and video in many different 
ways to create unique learning material for specific 
purposes. Teachers can maintain student interest and 
involvement by combining a variety of media in one learning 
activity.  
The SANAKO Study Content Authoring Module software and 
license are included in the basic Study 500 package. 
The content authoring software application provided by the 
Study Content Authoring module offers a variety of different 
media formats that teachers can easily incorporate into 
learning material. Once the content has been created, all the 
lesson materials can be saved as a single file making 
storage and usage of the material easy.  
When creating learning material with the Content Authoring 
Module, the teacher first selects a media file to function as 
the basis of the content project and can then freely add other 
elements, such as images, audio files, video and subtitles. 
When adding different elements to the media file, the teacher 
define the exact point in the media file when each element is 
to be displayed to students, as well as add bookmarks that 
help to easily locate places in the file for quick review. 
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SANAKO STUDY EXAMINATION MODULE 
The Examination Module is a valuable tool that simplifies the 
creation and administering of tests. The Examination Module 
includes a 6-step “wizard” application that assists and guides 
teachers in the creation of tests. The flexibility of the 
Examination Module allows teachers to easily vary the types 
of test questions and to edit any existing tests. 
The Examination Wizard allows instructors to design any 
type of question to test a particular skill or student ability. 
Teachers may even set the time and outline instructions for 
tests before administering them, as well as preview entire 
exams.  
The Examination Module provides important follow-up by 
generating test results for both student and teacher, allowing 
students to receive immediate feedback on their 
performance or the teacher may choose not to show the 
students their results immediately. 
Students answer tests easily and conveniently using the 
SANAKO Exam Player and teachers use the regular activity 
selection procedure in the Study 500 to launch exam files for 
students. Students may also use the Exam player in stand-
alone mode for additional exam practice or review. 

SANAKO STUDY MOBILE MODULE (AVAILABLE IN 
UK ONLY) 

SANAKO Study Mobile Module allows teachers and students 
to participate in a SANAKO Study live learning session 
through Nokia N810 Internet Tablets. The handheld Nokia 
devices allow teachers and students to extend the learning 
environment to home and on the move.  
The Nokia N810 Internet Tablets pack all the features of a 
PC into a pocket-sized device with Internet connectivity and 
come with pre-installed SANAKO Study software. The Study 
Mobile Module allows the teacher to focus students within an 
interactive learning environment regardless of the students’ 
physical location.  
The Study Mobile Module features include student screen 
locking to keep learners on task, voice and text 
communication for guidance and instant feedback, teacher-
controlled Web browsing, student thumbnails and screen 
monitoring, and grouping for collaboration and interaction.  
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SANAKO STUDY VOTING MODULE 
The Voting Module provides teachers with a quick snapshot 
of student understanding of a given subject, allowing them to 
immediately correct mistakes and misconceptions. It helps 
support effective instruction and ultimately improves learning 
outcomes. The Voting Module adds two new buttons to the 
Study interface, Live feedback and Voting.  
With the Live feedback feature, students can let teachers 
know if they are following the lesson or if they are having 
difficulty, which helps the teacher match the teaching speed 
with the students skill level. 
The Voting feature allows teachers to run on-the-spot 
queries to determine student engagement and to test 
students’ understanding of the subject through multiple 
choice questions.  

SANAKO STUDY VIDEO STREAMING MODULE 
The SANAKO Study Video Streaming Module enables 
teachers to stream video from a variety of analog sources, 
including DVD and VHS players, or from media files directly 
to students.  
The module consists of a SANAKO video streaming 
hardware server with SANAKO software, and a simple 
browser interface for administration and video stream 
management. The SANAKO Video Streaming Module is 
ready to be used once the video streamer is installed on the 
LAN, and one or more video sources are cabled to the video 
streamer.  
The module allows teachers to display video to students, or 
to simultaneously send the video material, digitize it and then 
save the video content as a media file for future use. The 
teacher can launch a video stream to student screens with a 
simple click of a Video Stream button in the SANAKO Study 
interface, or by selecting it as a media source in language 
learning activities. 
Note: The SANAKO Study Video Streaming Module requires 
Quicktime 7.0.3 or later.  
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